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Microsoft Office Interface 
Microsoft Office 2010 improves the ribbon interface that was introduced in Microsoft Office 2007.  The Microsoft 

Office Ribbon is a set of tools that are grouped together in a related set of tabs.  

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
Tools on each ribbon tab are further organized into logical groups called ribbon groups.    In the example below, 
Insert is the active tab of the Ribbon and objects that can be attached to an e-mail message can be found in the 
Include group of the Insert tab. 
 

 
 
 
 
 
 
 
 

 
 

 

 

Quick Access Toolbar 

Tools shown here are 

always visible.  You can add 

your favorite tools to this 

toolbar. 

Ribbon Tabs 

Click any tab on the ribbon 

to display the tools that are 

related to that task. 

Ribbon Groups 
Each ribbon tab contains groups, and each group 
contains a set of related tools. Here, the Respond 
group on the Home tab contains tools for responding 
to e-mail messages 

Dialog Box Launchers 
Dialog box launcher icons next to any 
ribbon group label can be clicked to 
open a dialog box with more options for 
that group. 

Hide the Ribbon 

Click this icon to minimize 

the ribbon and provide 

more work space. 
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File Ribbon Tab 
The Microsoft Office Button that was introduced in Microsoft Office 2007 and was found in the upper-left 

corner of select areas of Microsoft Outlook 2007 has been replaced with a File tab on the ribbon in Microsoft Office 

2010.   Clicking on File will open a full screen menu that will default to the Info view {1}.  This view contains Account 

Settings {2}, Out of Office messages {3}, cleanup tools {4}, and rules {5}. 

Selecting Options {6} opens the Outlook Options menu in which the settings of Microsoft Outlook 2010 can be 

configured.  Settings include configurations for mail, calendar, contacts, tasks, language, ribbon customization, and 

the Quick Access toolbar. 

 

 

 

 

 

 

 

1 

2 

6 

3 

4 

5 



6  © 2010 Eastman Computing Services 

Microsoft Office Quick Access Toolbar 
The Microsoft Office Quick Access Toolbar allows for a customizable toolbar displaying a set of commands 
independent of the tab on the Ribbon that is currently displayed.. 
 

 
 
To customize the Quick Access Toolbar, click the down arrow to the right of the commands.  A popup menu will 
appear with available commands.  Click on the command to add it to the Quick Access Toolbar.  If you don’t see the 
command you want in the popup menu, select More Commands from the menu.  This will open a new window that 
will allow you to select from all available Office commands.  You will also find the option to display the Quick Access 
Toolbar below the ribbon. 
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Appearance of Outlook 
 

After opening Outlook, you will be taken to your Inbox and the following screen will be displayed: 

 

The left hand panel of Outlook lists the mail folders (Navigation Pane).   If you do not see this list, click the View tab 
 Navigation Pane  Normal.  The navigation pane contains the following components: 
 
Inbox – The Inbox is where new e-mail messages arrive until moved to another folder or deleted. 
Drafts – Messages that you start are stored here until sent out.  If composing a message, you can close it and 
retrieve it from this location at a future time. 
Sent Items – Once a message has been sent, it will be stored in the Sent Items folder.  This allows you to see when 
an e-mail message was sent and gives you the ability to reference messages you sent to others. 
Deleted Items – Items that have been deleted from Microsoft Outlook are stored here until permanently deleted.  
All items can be removed from here by right-clicking on Deleted Items and selecting Empty Folder. 
Calendar – The calendar and scheduling component of Microsoft Outlook.  This allows you to manage your calendar, 
organize meetings, and manage other people’s calendars. 
Contacts – The contact management component of Microsoft Outlook.  This allows you to manage contacts and 
contact groups. 
Journal – This component allows you to automatically record actions that are performed in Microsoft Outlook. 
Junk E-mail – E-mail messages that are classified as junk are automatically sent to this folder. 

To-Do Bar Navigation Pane 
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Notes – This component allows you to create ‘sticky notes’ within Microsoft Outlook.  Notes are useful if you have a 
short note that doesn’t belong in an e-mail message, appointment, task or contact. 
Outbox – Messages are stored in this folder very briefly before being sent.  After clicking the Send button on an e-
mail message, the message will be stored in Outbox for a few seconds before being sent to the e-mail server. 
RSS Feeds – This provides an easy way for you to read the latest postings to your favorite Web sites. 
Search Folders – A virtual folder that provides a view of all e-mail items that match specific search criteria. 
Tasks – The task component of Microsoft Outlook.  This allows you to create tasks or “to-do” items, track the status 
of the task, and assign tasks to another person. 
 
The center panel displays the content of e-mail, calendar, contacts, notes, and tasks. 
 
The right hand panel of Outlook displays the To-Do Bar.  This bar can be configured to show mini calendar months, 
upcoming appointments, and your task list.  The To-Do Bar can be turned off completely by going the View tab  
To-Do Bar  Off.   
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E-mail 
 

Reading New E-mail 
 

To open new mail messages, 

click on the Inbox folder in the 

Navigation Pane.  All new 

messages are highlighted in 

bold.  The number of unread 

messages will appear in 

parenthesis next to the Inbox 

folder.  Select the message you 

want to read by double 

clicking it. 

 

 

 
 

Sending a New E-mail Message 
To send a new e-mail message, click on the New E-mail button on the Home tab of the ribbon.  Enter the recipient’s 

e-mail address in the To… line, or if the recipient is a contact or part of the University of Rochester, you can simply 

type their full name.  For multiple recipients, make sure you separate addresses with semicolons.  If you click on the 

To… button, the Eastman address list or global address list will open, and you can search and select the name(s) you 

want, press To and then click ok.   To send a copy of an e-mail to another person that is not the main recipient, 

put their name in the Cc… line. 

The subject of the e-mail should be entered into 

the Subject: line and the body of the message 

should be written below that.  When the 

message is finished being composed, click Send.  

If you are not online, the message will go to the 

Outbox until you have an Internet connection. 
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Replying to and Forwarding Messages 
If you wish to reply to an e-mail, click the Reply button in the ribbon and complete your message 

just as you would a new e-mail.  If you wish to reply to all senders, including those copied in on 

the received message, hit Reply to All.  By default, replying includes the original message at the 

bottom of the e-mail.   

To forward a received e-mail to another person, click on the Forward button in the ribbon and then add the e-mail 

addresses you want the message to be forwarded to.  To change replying and forwarding options, go to File  

Options  Mail, and then scroll down to Replies and forwards.   

Deleting E-mail Messages 

To delete a message, click on the message and then click the  icon on the ribbon or use the Delete key.  To delete 

multiple e-mails simultaneously, click on the top message you wish to delete, hold down the Shift key, click on the 

bottom message you wish to delete, and then click the  icon or use the Delete key.  To select multiple messages 

for deleting that are not in a row, hold the Ctrl button and select the messages one by one that you wish to delete.  

To select all messages within a mail folder, right-click on a folder and select Delete All. 

When messages are deleted, they are kept in the Deleted Items folder.  These messages still count towards your 

quota limit, so they must be permanently deleted from the Deleted Items folder.  To empty the entire deleted items 

folder, right-click on Deleted Items and select Empty Folder.   

To delete the Deleted Items folder when you exit Outlook, select File  Options  Advanced.    

Select the Empty Deleted Items folders 

when exiting Outlook check box. 

 

 

 

To be notified before you empty the Deleted 

Items folder, select the Prompt for 

confirmation before permanently deleting 

items check box.  Click OK when you are 

done. 
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Sorting Messages 
E-mail messages can be sorted by Subject, Date Received, Sender, Size, etc. depending on how you want to view 

your messages.  Usually it is easiest to sort mail by date received.  To sort by the desired category, click on the 

category header, such as Subject. 

If one of the categories that you would 

like to have in view or that you like to 

sort by seems to be missing from the bar, 

right click on the category header and 

select Field 

Chooser.   

Then drag 

the field that 

you want from the Field Chooser window to where you want it on the category header 

bar.   When you are finished adding any new fields, you can X out the Field Chooser 

window.   

 

 

 
 

Working with Attachments 

Adding Attachments 

A file attachment can be added to a message.  Click the Attach File button on the ribbon and browse for your file.  A 

file can also be dragged into the body of the e-mail window.  After the file has been attached, a logo of the file and 

its name should appear within the header or body of the message.  

 

Opening Attachments  

A message that has a paperclip icon indicates that it has an attachment.  To 

open the attachment, open the e-mail message and then double click on the 

attachment.  You will be prompted to Open or Save the attachment.  If you 

plan on editing the document, it’s best to save the attachment to your 

Documents folder and then open from there.  
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Saving an E-mail Message as a Draft 
If you are not able to finish writing an e-mail message, you can save the message as a draft to be completed at a 

later time.   Close the message and when prompted if you want to save the changes, select Yes.  The draft will then 

be saved in the Drafts folder.   To return to this message, go to your Drafts folder and double click the message to 

open. 

Spell Check 
Before sending your message, it is a good idea to use Spell Check to make sure that you do not have any errors in 

your e-mail.  To start the spell check, click the Review tab and then click the Spelling & Grammar icon. 

 

Check Names 
When filling in the To… line with addresses you want to send to, if 

you are not sure about a name, use the Check Names feature.  For 

example, you cannot remember the last name of the person you 

wish to email, write the first name and then click the Check Names 

icon on the ribbon.  You will be given options to choose the correct 

name.  

 
 

 

Message Options and Priority 
To change the options for a mail message, such as priority, sensitivity, delivery receipts, and other delivery options, 

open the Tags dialog box by clicking the expansion arrow next to Tags in the Message ribbon tab. 

 

E-mails can also be marked with high priority by clicking on the  icon on the ribbon.  Make sure you use the high 

priority icon with caution; constant use will make recipients not take the priority seriously.  
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The level of importance for e-mail messages can be set to indicate whether the message needs the recipients' 

immediate attention or can be read later.  Messages marked with high or low importance will display an icon next to 

the message in the recipients Inbox.  In addition, you can include a sensitivity setting to indicate how the recipient 

should treat the contents of the message. 

Polls can be setup by using the voting buttons 

option.  This allows you to send a question 

out to a group of recipients and then have 

results tabulated automatically when 

recipients respond to the poll.  Note that this 

only works among Microsoft Outlook users; 

Entourage is incapable of using this feature.  

Receipts can be requested for when a 

message is delivered and when a recipient 

reads the message that you sent. 

Replies to your message can be automatically 

sent to another recipient.  Messages can also 

be automatically delivered at a specified date 

and time. 

Storage Space 
Each person has an e-mail storage quota set to 500000K.  To check your storage size, right click on 

username@esm.rochester.edu in the Navigation Pane and select Data File 

Properties… Click on the Folder Size button and a window appears giving 

the size of each of your folders.   

You can now look through the list and see which folders are large in size.  

The example here shows a Deleted Items folder that is larger than the 

others.  If you are getting e-mails warning you that you are at your quota, 

you may want to move some of the items from the larger folders to a 

Personal Folder File (explained below) or delete e-mails that are no longer 

needed. 

 

 

 

 

 

 

Total Used Quota 
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Saving E-mails (Personal Folders File) 
Older e-mail messages can be moved to a personal folders file so that they no longer count against your e-mail 

storage quota.   

To create a new personal folders file, perform the following steps: 

File  Account Settings  Account Settings  

Click on ‘Data Files’  

Click the Add button  

Navigate to your H: drive and type in username.pst where username is your e-mail account username (ex. 

jbeyette).  Saving the file to your H: drive will make it accessible only by you and ensure that the file is backed up on 

a nightly basis. 

Click the OK button. 

Click Close.   

The folder should appear within the Navigation Pane. You can create folders within your 

personal folder to organize saved e-mail messages. 

 

 

 

 

 

 

Junk E-mail  
Everyone gets junk e-mail that they do not want.  The University provides a junk e-mail filtering service that is 

reasonably effective, stopping e-mails from even making it to your inbox.  Instead, an e-mail is periodically sent out 

listing all the e-mails blocked by the filter.  This way, you can be sure that e-mail that is not junk is not being stopped 

from arriving to your inbox.  Spam settings can be managed at: https://www.rochester.edu/it/spam. 

 

https://www.rochester.edu/it/spam
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Creating a Signature  

1. Go to File  Options  Mail and then click the 
Signatures button. 

2. Cclick New.  Enter a name for your new signature and 
click OK.  

3. Enter your signature in the Enter Signature box. 
4. Select if you want a signature to appear by default when 

you compose a new message or reply/forward a message. 

 

 

Setting up Rules 
Rules can be set up for a variety of purposes.  You can set up a rule to 

move messages from a specific address into a certain folder.  You can 

also flag messages from an individual or move messages based on 

content, etc.  All this is done with Rules.  To create a rule, go to File  

Manage Rules & Alerts.  Then click on the New Rule… button.  The 

Rules Wizard will allow you to create a rule from a template or start 

from scratch.  Select the option you want on each part of the wizard 

and click Next to move on to the next part of the Wizard.  Click on 

Finish when you have completed.   

 

 

 

Creating Filters 
A filter is an easy way to view only those messages or items that meet conditions you specify.  For example, you can 

apply a filter so that you only see messages that contain the word "audition" in the subject. The items that are not 

displayed when a filter is applied are still in the folder and can be seen again by removing the filter. 

1. Click on the folder that should have the filter applied. 
2. Click on the View tab, click on View Settings, and click Filter. 
3. Select the filter options you want and click OK. 
4. To filter using additional criteria such as a category or importance level, click the More Choices tab and then 

select the options you want. 
5. To remove the filter, repeat step 2 above. Then click the Clear All button and click OK until you are back at the 

message folder. 
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Contacts 

Create a New Contact 
To create a new contact, go to Contacts and then click the New Contact icon on the ribbon.  You may then enter the 

contact’s 

information.  If 

you enter their 

full name and e-

mail, then when 

filling out the 

To… line, you can 

simply write their 

full name rather 

than their e-mail 

address.  Tab 

through the 

contact window 

to enter other 

details about the 

person or 

company.  When 

you have 

finished, click on the Save and Close button.   

Create a New Contact Group 
Contact groups are often helpful when sending out e-mails to a large number of contacts.  Rather than having to re-

enter e-mail addresses every time a 

new message is sent, you can create 

a contact group that saves all the e-

mails in one list.  

To create a new contact group, go to 

Contacts and then click the New 

Contact Group icon on the ribbon.   

Enter a name for the contact group. 

If the addresses are part of the 

Eastman List, Global Address List,  

or a personal contact, click on Add 

Members and then on ‘From Outlook Contacts’ or ‘From Address Book’. 

If you have new addresses that aren’t already in the system as part of the University or as a personal contact, click 

Add Members and then on ‘New E-mail Contact’. 

After you have added all of the e-mails, click the Save and Close button. 
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To send to a contact group, open a new e-mail message, and write the name of the list in the To… line.  The name 

should become underlined and bold.  If you created the contact group in the past, it is often a good idea to open the 

list and click on the Update Now button.  This will make sure all the e-mails are up to date. 

Finding Contacts 
To search for a contact, click in the Search Contacts field, enter the name, and press enter. 

 

Sending a Contact or Contact Group 
To e-mail contact information to another person, while in the contact folder, right-click on a Contact or Contact 

Group, select Forward Contact  As a Business Card.  This will open a new e-mail with the contact information 

attached. 

Delegating Permissions (Sharing folders) 
In some instances you may want to delegate permissions for 

someone else to have access to your Contacts, Calendar, 

Tasks, or Notes.  To add someone as a delegate, go to File  

Account Settings  Delegate Access.  Click on the Add… 

button and then find the name of the person and click on 

Add.  Their name should appear in the right hand side 

box.  Then click on Ok.  The Delegate Permissions window 

should open.  You can then change the level of permissions 

for this person for each folder.  In this example, the person 

has permission to edit (read, create, and modify) the 

calendar; review (read) the tasks; and author (read and 

create) contacts.   

 

Opening Another Person’s Contacts (or other folder) 
To open another’s contact list, first be sure that the person has given you permission and made you a delegate for 

Contacts.  Then go to File  Open  Other User’s Folder…  Click on the Name… button, find the name of the 

person and click Ok.  In the Folder type: drop down, select the 

folder that you wish to view.   

In this case, select Contacts and click Ok.   
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Calendar 

Calendar Views 
The calendar is a useful tool for keeping track of important dates, meetings, and appointments.  Once you are in the 

calendar, you have several view icons on the ribbon to choose from: Day, Work Week, Week, Month, & Schedule 

View.  Within the Month view, you can select how much detail you want to show (Low, Medium, High).  Use the 

Today icon to automatically move the view to today’s date.  When on the Week or Month view, double clicking on a 

day will take you to the Day view of that particular day.  Use the Next 7 Days icon to display the next 7 days in week 

view.  Below is an example of a Month view with High details.  
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Set Calendar Preferences 

1. Go to File  Options  Calendar.  
2. Under Work time, select the start and end time you want for your work hours and what days you want as 

part of your work week. 
3. Under Calendar options, select Default reminder to have Outlook 2010 remind you automatically of all 

appointments. Then, in the drop-down box, select the amount of time before appointments you want to 
receive the reminder.  You can change this time for individual appointments when you create them. 

4. To have Outlook 2010 automatically display holidays for different countries or religions, click Add Holidays, 
select the locations whose holidays you would like added to your Outlook Calendar and click OK. 

5. To extend your calendar free/busy information for meeting request purposes, click the Free/Busy Options 
button and enter how many months of free/busy information you would like available on the server.  By 
default, this value is set to 2 months, but if you have a lot of meetings scheduled for the long term, it is best 
to increase this value. 

6. Under Time Zones, select a time zone. 
7. When you are finished, click OK. 

Adding a New Appointment 
To create a new appointment, while in the 

Calendar, click on the New Appointment icon.  

Then enter the Subject, Location, Start time, and 

End time of the appointment.  Check the box All 

day event if there is no specific time for the 

event.  

You can add attachments, change the priority, set 

reminders, or print the appointment.  When 

finished creating your appointment, click Save 

and Close.  

Recurring Appointments 
For appointments that occur every week or every month, or at some 

other interval of time, there is no need to create a new appointment 

for each occurrence.  Click on Recurrence… if the meeting repeats on 

a set schedule, and set the appropriate dates and times.   

When you want to change/cancel one meeting within a recurring 

series, be sure to open just the single occurrence.  Open the series to 

make changes to all appointments.  When you open a recurring 

meeting, you will be prompted to open a single occurrence of the 

series. 

Changing/Deleting Appointments 
To edit an existing appointment, double click on the meeting.  When finished editing, click Save and Close.  To 

change the time of the appointment, drag the appointment to the time slot you want while in the calendar.  You can 

also resize the appointment to change the length or click within the appointment box to change the title.  To delete, 

double click to open and then click the delete button on the Office ribbon. 
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Mark an Appointment as Private 
1. Open the calendar item you wish to make private 
2. Click the Private icon on the Office ribbon. 

 

 

Show you are Free/Busy during an Appointment 
1. Open the appointment/meeting you wish to change 
2. Change the pull down menu that says Show As to: Free, Tentative, Busy, or Out of Office 

Sending Meeting Requests 
To change an appointment into a meeting request, click on the Invite Attendees… button on the ribbon.  Then click 

on the To… button, select contacts just as you would for sending an e-mail.  The recipient will receive an e-mail 

requesting them to accept, accept tentatively, or decline the meeting invitation. 

Write a message you want sent to your recipients in the body, and be sure to fill out the subject, location, start time, 

and end time just as you would for an appointment.  You will receive confirmation of people who accept the 

invitation.  

Availability of Meeting Attendees  
Sometimes before scheduling a meeting, it is best to see when your attendees will be available.  The best way to do 

this is to start with a new 

meeting.  Then click on the 

icon that says Scheduling 

(next to Appointment tab).   

Enter in the names of the 

attendees on the left hand 

side and then their free and 

busy times should appear 

under the dates shown.  

You may scroll through the 

dates with the scroll bar 

near the bottom of the 

window. 

A feature called AutoPick 

Next will automatically find 

the next time that all 

attendees are available for the specified meeting length. 
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Changing Requested Meetings 
After editing a meeting request that you had previously sent out, make sure to click on Send Update to send the 

updated request to all recipients.  Any changes you make to time, location, subject, and attendees will send an 

update to all invited people. 

Cancelling Requested Meetings  
If you need to cancel a meeting you requested, open the meeting and then click Cancel Meeting and then Send 

Cancellation.  If you are cancelling one meeting out of a series of recurring meetings, make sure you open the 

occurrence of the meeting.   If you are cancelling a recurring series of meetings, open the meeting as a series before 

cancelling the meeting. 

Receiving a Meeting Request 
If you are invited to a meeting, a calendar icon will appear next to the e-mail message.  After opening the message, 

you will see information about the meeting, such as date, time, location, description, and who has been invited.  You 

can then choose Accept, Tentative, Decline, or Propose New Time.  If you are not sure if you can make it or not, you 

should choose Tentative   so that the meeting shows on your calendar until you decide.  The person who requested 

the meeting will receive   an update on your decision. 

 

 

Printing Calendar Items 
Go to File  Print. Outlook displays a list of 
available print styles.  Select the style you 
desire.  If you wish to make further changes, 
click the Print Options button and then the 
Page Setup button. 
Choose the options that you want, and then 
click on OK followed by Preview. 
If everything looks correct, click the Print 
button at the top of the window. 
If not, click the Print Options button and then 
the Page Setup button and make changes 
until satisfied. 
 
To print just one event, click on it and go to 
File  Print, select Memo style and click 
Print. 
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Sharing Your Calendar/Opening Another Person’s Calendar 
 

In some instances, you may want to share your Calendar with another person here at the University.  In order to do 

this, you first need to delegate permissions to the person that will be accessing your calendar and set their 

permissions level.  For step-by-step instructions, see Delegating Permissions, page 17.  The person that will then be 

opening your calendar will need to follow the instructions on how to do so.  This can be found under Opening 

Another Person’s Contacts (or other folder), also on page 17.  Make sure when following these steps to use the 

Calendar folder rather than the Contacts folder.  After opening another user’s calendar for the first time, you can go 

to the calendar and select the user from a history list. 

You can open user’s 

calendars side-by-side by 

selecting which calendars 

you want to see. 

 

 

 

 

 

 

 

 

You can also overlay users 

calendars on top of each 

other by clicking the arrow 

on each user tab to more 

easily find potential meeting 

times.  In the example to the 

right, the first user’s calendar 

items are in gray, the second 

are in blue, and the third are 

in green.  Selecting a user will 

put the focus on that user, in 

this case, the first user.  
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Tasks 

Creating a New Task 
Tasks can be used to remind you of important things that need to be done.  To create a new task, go to Tasks and 

then select New Task on the ribbon.  

Fill out Subject, Start date, Due date, 

Status, Priority, % Complete, and a 

Reminder as needed.  When you are 

finished, click Save and Close. 

Completing a Task 
Once you have completed a task, go 

to the Tasks folder.  To mark the task 

as complete, check the box to the 

left of the task subject.  You can also open the task item and use the Mark Complete button on the ribbon.  This 

method will give you the opportunity to enter any additional notes regarding the task. 

 

Assigning a Task 
To assign a task to someone else, click the Assign Task button on the ribbon, enter the name of the person who will 

be assigned the task, and click the Send button.  Once the person has marked the task as complete, you will receive 

an update for your task list that the task has been completed.  

 


